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1 Introduction

Welcome to the MotiveWave™ Docking Framework Guide! If you are reading this document then you
have already installed MotiveWave™ on your computer and you are ready to start using the application.

If you have not yet installed MotiveWave™ or registered for a trial on our website, please read the
Installation Guide before continuing on with this document.

The MotiveWave Docking Framework provides a flexible system to manage multiple panels (such as
charts, watch lists etc) within a single application window. This document will outline and explain the
features associated with this framework.

1.1 Elements

When you first open a workspace in MotiveWave™ the console will be displayed with the default layout.
Depending the broker/data service(s) you added to the workspace, the console window will look similar
to the screen shot below:
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The console has a number of elements outlined below. These elements will be explored in detail in this
document.

1. Stations — Stations contain one or more panels (charts, watch lists, etc) stacked on top of each
other. The panels are directly accessible from the tabs in the top tab bar.

2. Pages — Pages contain one or more stations arranged in a layout. An application window
(Console or Desktop) may contain multiple pages that are accessible from the page tabs at the
bottom of the window.
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3. Layouts — Stations are arranged within the page using a layout. Two types of layouts are
supported: Split Layouts and Floating Station layouts.

1.2 Desktops

The examples provided in this document are from the Console window (main application window). The
Professional and Ultimate editions also provide Desktop windows that use the docking framework.
Desktops may be created/accessed from the Console menu bar (File -> New -> New Desktop and File ->
Open -> Open Desktop):

m MotiveWave - Console (CQGA)
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2 Stations

motivewave’

A station holds one or more panels stacked and accessible from tabs at the top of the station. The

screen shot below outlines some of the elements in a typical station:
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2.1 Station Tool Bar

v EFx = v |®@ |-~ B2

CQG - SIMmwaveapi =
Pos: Flat P/L: 0.00

The station will display a tool bar that is specific to the active panel (if one is defined for the panel). In

the case below the watch list tool bar is displayed:

Panel Specific Tool Bar

(Watch List in this case):%\ il
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2.2 Pop Out Panels

A panel can be “popped out” into a separate application window by clicking the pop out button on right
side of the tab bar. The original panel stays in the station and a copy of that panel is opened in a
separate application window. Application windows can be managed from the Window menu in the top

menu bar.
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2.3 Reorder Tabs

The tabs in the station can be reordered by dragging them with the mouse (left click and hold while
moving the mouse). A vertical blue bar highlights the location where the tab will be placed after
releasing the mouse button.

m MotiveWave - Console (CQGA)
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Release the 4—

Drag tab to the mouse button to
desired location on drop the tab.

0

drop location.

blue bar shows the
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After releasing the mouse button the tab is dropped at the given location. The tab is made the active
tab in the station.

m MotiveWave - Console (CQGA)
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2.4 Creating New Panels

A new panel may be created by click on the + button to the right of the last tab in the station. Several
different types of panels are available (depending on the edition of MotiveWave™).

m MotiveWave - Console (CQGA)
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The new panel tab will be added to the end of the list of tabs in the tab bar:

I
g

m MotiveWave - Console (CQGA)
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2.5 Active Stations

The color of the tab bar will change if it is the active station. There are two types of active stations:

1. Active Chart — This station contains the active chart for the tool bar(s).
2. Active Focus — This station has the current input focus.

2.5.1 Active Chart Station

The tab bar for the station that contains the active chart will have a light blue color (dark blue in the
Dark Window theme). The highlight visually indicates which chart the tool bar is currently associated
with. Contextual settings for these controls reflect the active chart (such as quick search symbol, bar

size, auto scale etc). All of the actions (buttons, drop downs etc) in the tool bar will apply to the active
chart.

Erzis v Q| S R Ev@0 Clwy & §v + =T m 2| 15mi L ICRE)
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EPZ19 X CLEF20 My Gauges BRKB r /
Active Chart
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Tool bar contextual
setting and actions apply
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“"ﬂlh*n-mm *
| F*+FI-+ 4 *+IFTT!

2.5.2 Active Focus

In cases where the active station is not the active chart station the tab bar will have a subtle blue color
to indicate that it has the input focus.
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3 Pages

Pages provide a convenient way to manage a virtually unlimited number of panels (charts, watch lists,
gauges etc) in different layouts. The page bar at the bottom of the Console window is initially
configured with several preset pages. Left click on a page tab to show the layout in the content section
of the window. In the default layout you will see the following pages:

1. Home — Contains a sample home layout with a chart section and two watch list sections on the
bottom.

Charts — Sample chart layout with six charts (2 rows, 3 columns)

Account — Account related panels including Accounts, Orders, Positions and Trade History
Scan — Sample layout for running a scanner and viewing the results in a chart

5. Optimize — Simple layout with the Back Test/Optimize panel.

PwnN

The screen shot below shows the page bar (at the bottom of the console window) and highlights some
of the features.

Active Page Tab Category Icon I Copy Page |
il Home

X il Charts 8 Account X [ Scan  {lf Optimize &% Floating  + m N O
Nov-1i14:16:48
Choose
Layout

New Page
Button

Hover over tab to
see the close button

3.1 Adding a Page

Click on the New Page Button (+ button to the right of the last page tab). This will show the New Page
dialog:
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The New Page dialog requires a name for the page (displayed in the tab) and a layout. Layouts are
arranged in categories:

1. Chart — Typical chart layouts. Some include watch lists and or account/order/position/trades
panels.

2. Account — Some account management layouts. Layouts include account, order, position, trades

and watch lists panels.
3. Scan — Layouts for performing scans (on Studies, Elliott Waves or Harmonic patterns).
4. Optimize — Layouts for optimizing/back testing strategies
5. Floating — Layout for floating stations.

An icon is displayed on the left side of the tab to indicate the category of the layout. The screen shot
below shows the new page added to the page bar (and active).
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3.2 Edit a Page
Click on the Edit Page button (right side of the page bar) to change the name and/or layout of the active

page:

Click here to
edit the page. o
im N

Nov-12 12:32:26
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3.3 Copy Page

motivelwave

In some cases, it may be convenient to copy an existing page instead of creating a new one. When a

page is copied the existing layout is copied including all of the stations and panels.
Click on the Copy Page button on the right side of the page bar.
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[l Home bl Charts 8 Account (5! Scan  f}f Optimize Ll My Charts X +

T W 2~|15m

[
EEEE -aim

AT - @ i~ T J--||-)<5mfg,,:<.>¢.
SIEZ19 X GCEZ19 + . X +EHAQEE »
SIEZ19 - 15 min e 0500 x|
. 167 16*
”i LW ‘ (e ol ce= Bly
bl ' i J16.800
! u .‘ " Lo00 m +0.00
Ii ' | f J16.850
+ o x|
* , . f"* g 120° | 120°
T‘ H il 4“ Sell Buy
'l ’ﬁ. haw I”h 1 |T J16.750
6.720) | Lo.00 m HO.00
1 a oo 3
14:05:00 X
J16.850
MotiveWave 10 2|1=-|
; = = . . . , . L \ \ . .
3:00 600 8:00 12:00 16:00 20:00 Nov-13  3:00 5:00 5:00 12:00 16:00 20:00 [~P7TeE )
OFA® 15min Reversal(d-8) 30sec 1min Smin 10min [16min  20min 30min 45min 1hour 78min >7 E-E S W@ 8 |n IEZI 000
CLEZ19 X NGEZ18  + 2 " L 14059 X

CLEZ19 - 15 min

174%
[Py Buy
[~ PiiTags )

_MW #* il TR

e m

«.00°
10 ¢ 1= ]

4 * +56.60 | L0000 m H0.000
I T F * 14:06:00 X |
e

+156.80

i‘ulun.!'h

T|m| e Lt

New Page Tab

MuuueWaue Added Here 56,20
Nnv 13 100 ZDD 300 400 sm GOD 700 Bﬁ)— [!Dl] 11:00 12:00 13:00 14:00 L0.00 m H0.00
OFA® 15min Reversal(4-8) 30sec 1min Smin 10min  1Smin | 20 min 30 min 4\_ AIH 1hour 78min *7 EvEv= v @ |+~ 2 CTEE o000 x)
L Home L Charts 8 Account  [i! Scan  {}f Optimize  Lul My Charts Ll My Charls2 X + m O

Nov-13 14:06:05
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3.4 Re-order Pages

Page tabs can be re-ordered by clicking/dragging a tab to the desired location. As you drag the tab a
vertical blue bar will appear that indicates where the tab will be placed.

Vertical blue bar
indicates where the
page tab will be placed.

l#l Home il Charts .8 Account |l Scan  {lf Optimize Ll My Charts X |:ul My Charts2 Ll My Charts 3 Ll My Charts4 il My Charts 5 Ll My Charts 6 + >a m O

Nov-13 14:17:16

Click and drag the tab
you want to move.
3.5 Overflow Tabs

There is no limit to the number of page tabs you can have. If there is not enough space to display the
tabs, an overflow button will appear with the number of unseen tabs in the label.

AEO NYSE 16.02 14:38:00 16.01 0.00 000 0.000 Ll My Charts 6
AXP NYSE 120.29 14:40:00 120.89 0.00 000 0000 |Choosethe =4 Ll My Charts7
page you want Wil My Charts 8
csx NASDAQ 71.96 1a:40:00 ([IERE) IR 7275 0.00 000 0000 |i make active L My Charts 9
DE NYSE 174.81 14:40:00 [IEED) A 176.39 0.00 000 0000 7T H Ll My Charts 10
r —— 164 & Floating
|l Home X Ll Charts 8 Account  [2¢ Scan  {lf Optimize bl My Charts Ll My Charts2 il My Charts3 Ll My Charts 4 Ll My Charts 5 + [*58' T L)

Number of EFFTFES
unseen tabs
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4 Layouts
There are two types of layouts available:

1. Split Layouts — All of the pages in the default layout use split layouts. In these layouts there is
one or more stations that are separated by horizontal/vertical splits

2. Floating Stations — In this layout the stations have absolute locations and sizes. Stations can be
sized and positioned individually.

4.1 Split Layouts

Split layouts use one or more splits (or dividers) to arrange stations on a page. Splits can be horizontal
(dividing the available width between two more stations) or vertical (dividing the available height
between two or more stations).

Splits set the relative size of the stations (ie a percentage of the window size instead of an absolute size
in pixels). If the size of the application window changes (either from maximizing or manual resizing) the
change in size will be distributed across all of the splits.

Splits can also be nested inside of other splits allowing for a flexible and diverse set of layout possibilities

The screen shot below shows the two splits in the default layout (highlighted in yellow). The vertical
split will adjust the relative heights of the stations. The horizonal divider will adjust the relative widths.

-.__.,...ﬁ,.,..._._.,.__.#._q____...,.hlllmnlnﬁ..‘.lhlm|i',

0 18:00 21:00 Nov-12 3:00 6:00 9:00 14:00 18:00 21:00 Nov-13
7 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month >>1 Ev B = v @ |0 B2
- EHQEEE Y~ @ 7 Grains (11) X + HQEEE Y- = .
. i . ; ; g 11:19:5
Bid Bid Size Ask  AskSize LastTime Expiry Dal * _— o Vertical Split. Click and '
3088.50 219  3088.75 79 12:38:36 201 9-12-1!. 3 drag to adjust the height
3088.50 52 3088.75 18 1 | 1%[=-4 of all three stations.

Horizontal Split. Click A

1990.2 4 1990.4 2 |and drag to adjust the  [2-11
width of the watch lists. $r218 - sec | (Loon kLl oo
0.0 0.0 2-1! | EAZEE 16:00:00 X | [EALZACHM  16:00:00 X

4.1.1 Moving Panels Between Stations

Panels can be moved between stations by clicking/dragging the tabs with the left mouse button. Drag
the tab to the center of the station to where you want it moved and release the mouse button. The
target station will be highlighted in blue (see below).
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[ ] MotiveWave - Consale (Dock)

EPZ19 MY i s e [ ©w~Q §~ Py + "B[T|&2~|15min - | 4 W e 1 |¥ o
EPZ19 15m X YMZ19 15m ar 1RV
EPZ19 - 15 min $3099.75

Volume g
' -:3095.00

@ | e blue highighted area w# l Hi i +

indicates where the panel 11 ! 1 ' 1

+ will be moved. !ﬂ H hd L ' l ]
Release the mouse button ! ﬁ + .- *‘ "ﬂ + f{20s0.00

to drop the panel in this 1

l T“ station. ]
ll F?H! ) (308525

lmlhﬂlﬁ HH Drag the tab toward
ﬁ' the center of the

desired station. ]

3080.00
18:00 21:00 21:00 Nov-14 i i : f

% 13000.00

Oct-2019 Oct-23 Nov-2019 i

30min  45min 1 hour

U Bv v = v (@l 8
Click and drag the REQEEE S Y-E,) Gas@ix + 2HEAEEE S Y-B

Symbol  Last Pricﬂ:hang t;iuw;?;:ﬁ;ﬁﬂ d  BidSize Ask AskSize LastTime  ExpiryDai+ EASSAlMN 50250 X| R{CALEEN soive X| .
EPZ19 3085.25 085.00 183 3085.25 99 9:03:03 2019-12- 1-.
MESZ19 3085.25 3085.00 62 308525 32 9:03:04 2019-12-1¢ 1=

75 .75

OFA®(8,3) i i i 20 min 2hour 6hour 1day 1week 2week 1month >1

Energies (5) Indices (12)

EMDZ19 1986.7 #1986.5 2 19867 2 903:04 2019121 | s - s || 5o m amran |
SMCZ19 0.0 0.0 0.00% 0.0 0.0 2019-12-1! ﬁi;iii 90303 X | EAUSILN 90227 X
_————— - o - - G S - -—— = - m—am- PR

m\

Ll Home X Ll Charts .8 Account |&! Scan  {lf Optimize  + m e O
TEFT LS ] Nov-14 9:03:04

The panel will be added to the target station (see below) and made the active station. You will see a
new tab in the station placed to the right of the previously active station.

® MotiveWave - Console (Dock)
EPZ19 - Q| W B s~ G |3 2w~ Q I~ Plv + =BT &2~|15min - | 4 W e 1 WO q»
EPZ1915m  Indices (12) X YMZ1915m  + —HEHQEEE Y- 2.

Symbol ce Change % Change Bid Bid Size Ask  Ask Size Last Time Expiry Date Open Close Low High +
EPZ19 FERA 308550 105 308575 132 903:31 20191219 309625 309625 308175  3099.75
MEszig | adde e o 3085.50 29 308575 50 00329 20191219  3096.25 3096.00 308175  3099.75

of the previously - .
EMDZ19 [ pc fp #1986.8 2 $1987.1 2 9:03:28 20191219 19916 1987.1 19823 19947
sMcz19 - 0.0 0.00% 0.0 0.0 2019-12-19 0.0 00 0.0
SPAZ19 30030 [IEDEIEXT 30855 3084.5 902:36 20191218 30080 30956  3089.0  3098.0
YMZ19 ziere [IEDEEE]  2revs 6 27679 3 90330 20191219 27772 27767 27637 27806
MYMZ19 +27679 [ EEE] + 27678 4 27680 3 90332 20191219 27765 27769 27636 27806
RTYZ19 #1589.5 EPYY #1580.4 10 15896 1 903:30 20191219 15032 15937 15858  1507.1
M2KZ19 1589.7 1589.4 5 #1580.6 6 90330 20191219 15044 15037 15857 15972
enaz1o  +8226.75 [IEEED) YR # 5226 50 12 48227.00 12 90331 20191219  8269.00 827025 821625 828550
mnazie  48227.00 [EERE FXFT + 8226.75 1 8227.00 12 90331 20191219 826500 827025 821650 8285.25
ENCZ19 0.0 0.0 0.00% 0.0 0.0 2019-12-19 0.0 00 0.0
Tab is removed
from this station.

Energies (5) ~ Alerts X + [l of o " Grains (11) X + ..'_" iii Qg I l ¥z,

Alerts (0) History (0) [ZCEZ19 RS

00 8 8 .
Symbol 4 Repl... Name Last Value Order Expires Activated Chart
Sell

37450 - 37750 | | 375008 m a7

02T 02 )
bl Home X |l Charts 8 Account |& Scan  {lf Optimize  + im Ny O
FEFT RS ® Nov-14 9:03:32
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4.1.2 Custom Split Layouts

There are many built in layouts for you to choose from in the New/Edit Page dialogs, but you can also

create your own custom layout by arranging the stations using the mouse.

Left click and drag any of the station tabs to move a panel into an existing station or to create a new

station.

In the screen shot below, the YMZ19 chart panel is dragged into a new station that splits the current

chart station horizontally.

sole (Dock)

EPZ1I9  ~ O W & B S @) (K ©| - & v pv + T T

- [ A (W18 13X 5 »
EPZ1915m X YMZ19 1 + "
epz19-15min )/ ¢3102.00
Volume Click and drag a o The blue shaded area indicates 43100.00
tab using the left where the panel will be "dropped”

In this case a new station is

mouse button. created splitting the current
station horizontally. J3095.00
4 3089.'@

|
m'*ij! '“1 i!l J 1' o 13085.00
ﬂ* Ith YMZ19 15m X
u'* ‘*

3080.00

The tab will move with
the mouse and highlight

nm' i+
'hr 'm!”ﬂl*ilﬁm JLM

the drop location using a
' alll—— blue shade
Motivelave__y ““h Tnn _1 — . ’ . . IIIHMM‘IWIEEIWII];
Nuv 1" 14:00 18:00 21:00 Nov-12 3:00 6:00 9:00 14:00 18:00 21:00
3000.00
un-2019 Jul-2018 Q18 |Aug2019 Aug-18 Sep-2019 Sep-15 Oct-2019 Oct-13 Oct-23  |Nov-2019
OFA®8,3) 1min 5min 10min 15min 20min 30min 45min 1hour 2hour Ghour 1day 1week 2week 1month 1 EvEv-= @~ =~ &
Indices (12) X Energies (5)  Alets  + —HQEEE Y- 2. Gralns(11) x + ||| Qe EE Y- = .
Symbol  LastPrice Change % Change  Bid  BidSize Ask AskSize LastTime Expiry Dal + : 16:00.00 X '
8 8
EPZ19 3080.75 3080.50 159  3089.75 146 123347 2018-12-1) M
e 185 sell [IIRE=y Buy
MESZ19 3089.75 3089.50 34 3089.75 35 12:33:47  2019-12-1: e e
EMDZ19 1991.3 1991.1 3 19913 2 123344 2019121 | |sars () s |ow (Gl Hom |
SMCZ19 00 00 0.00% 0.0 0.0 2019-12-1 @ T Bl 000X
,,,,,,,,,,, Lt e——— —mma mmma a tmasoma
[ ;014 | .02° |
|4l Home X Lul Charts .8 Account [ Scan  {lf Optimize  + LR

Nov-12 12:33:49

The screen shot below shows the new station created that splits the area occupied by the original chart

station with a horizontal split.

Version 1.0 ©2019 MotiveWave™ Software

Page 16 of 32



MotiveWave ™

Docking Framework motive_"a Ve@

YMZ19 ~Q|EE R s @l IR 2w~ & §~ P~
EPZ1915m X +

EPZ19 - 15 min
4 H|
“ h l H*T New Chart Station
w created with one panel.
=27700
+3090.00
| Horizontal split
created dividing the 27650
chart station in two. [g5 5o
l#l
i|1""1 *ﬁ Jar600
Haos0.00 | “m!
+| 'W'Hﬂl Jarss0
4
@ MotiveWays | * ¢ 2823
18:00 21:00 Nov-13 3:00 6:00 9:00 14:00 18:00 21:00
43000.00 [ 427500
Jun-2019 Aug-2019 Sep-2019 oct-27 Jun-2019 Aug-11  |Sep-2018 0ct-2019 Nov-2019 | 25000
1min 5min 10min [15min 2 =~ = v @ |+l 2 1min 5min 10min | 15min iz EvEr= v @ M- 8
Energies (5) Indices (12) X Alerts  + “mEaQegsee Y~ @ " Grains (1) X + Y2

Symbol LastPrice Change % Change Bid Bid Size Ask Ask Size  Last Time Expiry Dal +

00 [
EPZ19 3004.00 [EFI IR 309375 43 3094.00 31 16:19:36  2019-12-1()
MESZ19 3094.00 3083.75 17 3004.00 18 16:19:35  2019-12-1¢ SE"’

EMDZ19 1990.7 1990.1 3 19907 1 16:08:46  2019-12-1 | |srs00 ([ 377s||Loon [ eon
sMcz19 00 00 0.00% 00 00 2019-12-1! F!EE- 160000 X 160000 X |
ffffff e e ———— S o o |
|l Home X |l Charts .8 Account  [&f Scan  fif Optimize ~ + m O

=TT RS o Nov-13 16:19:41

In the screen shots below another panel is created (Gauges) and is dragged into a nested vertical split
with the stations that we created in the previous example.

onsole (Dock)

&~ | 15 min 3 | sme 1|} G >»
(L]

EPZ19 * Q& =h
EPZ1915m X Gauges o = " ymzi915m x +

EPZ19 - 15 minof’ /308650 YMZ19 - 15 min

'
Volume / Volume
+3095.00 T‘+
Click and drag l
tab with the left

mouse button. 505550 m |‘
r*'“ .

Added a panel
"Gauges" to this

27736,

3090.00

Release the mouse
button to split this station
vertically and create a

new station below.

@ MoliveWays | Gauges KW
. HelveNeg, ! :

3080.00

MDIWBWGVE

H
Nov-13 3:00 21:.00 Nov-13 3:00 f \ 14:.00 18:00 21:00
i =
+]3000.00 Drag the tab to the
1 bottom of the new
Jun-2019 Aug-2019 Sep-2019 Oct-2019 Oct-27 Jun-2019 Aug-1 station. Drop | "

1min Smin  10min [18min >72

= e~ @ o> B8 dmin Smin 10mif s highiighted in blue.

Energies (5)  Indices (12) X Alerts  + —EQEE8E Y~ @ " Grans(11)x +
Symbol LastPrice Change %Change  Bid  BidSize Ask AskSize LastTime  ExpiryDal+ 161502 X

[ 1] 00
EPZ19 3002.50 3002.50 123 300275 55 16:29:52 2019—12-11'
MESZ19 3092.50 3092.50 20 309275 17 16:2051 2019121t SE“’

sen

L L
EMDZ19 1989.5 0.12% JRELTX] 3 19897 6 16:29:34 2019121 |so0 (g s7s | oos (g Moos
sMcz19 00 00 0.00% 00 0.0 2019-12-11 FE- mzmx\ 0000 X
S ——— ] 30> | 30 |
lil Home X il Charts .8 Account [ Scan ar T TR
=== 0@ Py Nov-13 16:29:54
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MotiveWave - Console (Dock)
EPZ19 ~Q|EE R s @l IR 2w~ & 0~ Plv + "F[T]&~]15min - a8 1M G m >
EPZ19 15m X + = . YMZ1915m x + = "

EPZ19 - 15 min {3093 50) YMZ19 15 min F‘ﬂ.l.""*l
Volume Valume -

riginal + "
%agugels" tab is G r‘m»l e +J."| hl
no longer here.
: ' Y L £3082.00 ‘“_“_,, -' |
'J&I ITIIﬂInI. ﬂh

NotiveWaye _hl‘r‘m‘ ot

~3090.00

Nov-i3  3:00 300 00 2100

[% {27500
25000

Jun-2019

1min 5min 10min [ 15min 72 Ev Ev = v @ |4+ A

~3085.00

bl

Gaugasx + + .

*
J3080.00 ’ 64.0 \ m f \ {.—41 \
4| 'h RSI(C.14) g - Ticks/15s ¢ B Delta Vol(15s
o o USDICAD EPZ19 CLEPZD YMZ19
Wi, s |

ch 13 3:00 6:00 9:00 14:00 18:00 21:00 New station is
% created and contains
3000.00 the Gauges panel.
Jun-2019 Aug-2019 Sep-2019 Oct-2019 Oct-27
1min 5min 10min | 15min *72 Ev Ev = @y @ |4+ A
Energies (5)  Indices (12) X Alerts  + —HEQEEE ¥~ @ " Gans(i)x + & Ei QEEE Y-2.
EZ19 16:18:02 X | [

Symbol LastPrice Change % Change Bid Bid Size Ask Ask Size  Last Time Expiry Dai +

: " 375
0.14% 304 At
EPZ19 3092.00 0.14% KL= 45 300225 54 163005 2018-12-1(]) ﬂl 5 Lo
MESZ19 3002.00 [[IETDEEEE 09200 17 16:30:04  2019-12-1¢ =
—_—

16:00:00 X | '

17 309225

P‘ﬂﬂﬁl
EMDZ19 1989.1 1988.7 5 19891 1 16:30:00 2019121 |00 [ srers | |Loom - T
SMCZ19 0.0 0.0 0.00% 00 0.0 2019-12-11 @ 160000 X ELEZER ie00:00.%
""" = ———— S— ' I 0> | 30> il oa' | .04 ]

|l Home X lul Charts 8 Account  [d Scan  {lf Optimize  + m O
Nov-13 16:30:05

4.2 Floating Stations

Floating stations provide an alternative to split layouts. In contrast, the stations have fixed locations and
sizes. The stations may also overlap other stations similar to application windows.

Unlike split layouts, resizing the window (or maximizing it) does not affect the sizes or positions of the
stations. Resizing may also cause a station to no longer be visible if its original position lies outside of
the new bounds of the visible area.

A floating station layout can be chosen when creating a new page or editing an existing page (see
below).
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YMZ18 ~QlEF & =Gl [ g2|w~ @ §~ piv + T[T|~[15min = | 2 (M8 1K O W >
EPZ19 15m YMZ19 15m x + 2 "

YMZ19 - 15 min 27801

Volume
This dialog allows you to add ajmy_m.jmame name of the page below, choose a layout (see below) and click on "OK".
Page Name: _ Floating < Enter a name 27750
o for the page.
lad Chart 8 Account [ Scan {J] Optimize |@* Floating ——'Select the
( e "Floating” tab. do7700
¢ 27684)
-
Select the
TT" L default layout 27650
" “'! 27637
i,
!T‘ 27600
J27s50
14:00 [ 4:00

w [% 27500
Jun-2019 Nowflo | 25000

OFA®(8,3) 1mir

Energies (5)  Ini

Symbol  Last
EPZ19 430
MESZ19 430
EMDZ19 1
sSMCZ19

{1f Optimize

2 Account |&2 Scan

Click the OK
button when

you are done.

A\

o ;JK Cancel

— Click here to create
a new page.

+ =

Sl 0 | 30 Il o1¢ ] .01 |

v (@ |-~ £
Y2

[
Nov-14 9:20:33

The default layout for floating stations includes two overlapping stations in the top left section of the

content area:

EPZ19 ~Q|E S E s @) ESIE RS
NGEZ19 15m X CLEZ19 15m +

'f‘.‘:'l' EPZ1915m X YMZ1915m  +
 EPZ19-15 min
Volume

TY‘“

bl

23.2K]
e il G

| ”
[ U‘X "‘ ‘l‘ll“”w ?"

MotiveWave - Console (Dock)
i M + ™8T | &2~ 15min =

Stations are allowed
to overlap. Clicking 73098.00
on a station will

move it to the front.

~3096.00

J3084.6v-—. Stations have fixed
positions and size.

14 00 18 DU 21 :00 Nov-14 3:00 6:00 9:00 14.0
OFA®(8,3) 1min 5min 10min ' 15min 20 min 30min > = &

i Home |l Charts ® Account  [& Scan  {lj Optimize

9 2

& Floating X+

Zmie X G >»

+ i N
Nov-14 9:23:46

4.2.1 Moving Stations

Stations can be moved (positioned) by clicking/dragging the empty section of the tab bar. The stations
can be placed anywhere, but must be at least partially visible in the content area.
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MotiveWave - Console (Dock)

EPZ19 MEYL 2] [ @~ & f~ M~ + “2[T]~]15min - | 2 e 1M G >
NGEZ19 15m X CLEZ19 15m —
NGEZ19 - 15 min
Volume
‘ !'.!l i
d* -mﬂ*l ‘|' IT* ‘ J2.670
' IT l“ " |‘ ! J2.660
-2.650
J2.640
~2.630 Click/drag empty section
2.625) of the tab bar with the
2,620 left mouse button.
EPZ19 15m X YMZ19 15m  + V
EPZ19 - 15 min

Volume

ul

— P | | i ‘ | Bounds of the station may be

14:00 18:00 21:00  Nov-14 300 500 300 1 !+ P'acei OtUtSIdei gf lher‘élslllble
OFA®(8,3) 1min 5min 10min 15min  20min 30min >*9 Ev = = Y I‘ ‘ 3{:@'-9 :m?nuﬁragegﬂi ally ‘ ?
r|| ” ‘“i |

Ll Home Ll Charts 8 Account [&! Scan  {lf Optimize & Floating X + + i N O
Nov-14 9:29:29

4.2.2 Resizing Stations

Similar to application windows, stations may be resized by dragging the corners or edges of the stations.

NGEZ19 15m X CLEZ19 15m + (]
NGEZ19-15min  EPZ1915m X YMZ1915m  + = - .7
Volume
EPZ19 - 15 min
Vo 43096.00
+ -3094.00
ii*JI m | “ l ~
*ﬂ U . 13092.00
. * "' ' + (309125 .
X . " * ” * + 73090.00 15 g5o(Click and drag a
< corner or edge to
' Jaoss.00 12 g4 reSiZe @ station.
308600 2
Jaosa00 1262
246K
me W P g .
21 00 Nov-14 3:00 6:00 9:00 14:00 18:00 j !
imin 5min 10min  15min >72 EvEr= v -2

Cursor will change
when its placed
. P 1 vl near a resizeable

14 00 18: 00 21:00 Nov-14 3:00 6:00 9:00 corner or edge.
OFA®(8,3) 1min 5min 10min ' 1Smin 20 min 30 min **9

e
4
[
4
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4.2.3 Sticky Edges

For convenience, the edges of the stations and the visible bounds of the content area are “sticky”. This
effect will cause the station to “snap” to the edge of another station or to the edges/corners of the
visible bounds when the station is dragged or resized. The feature makes it easier to layout the stations.

The sticky option can be disabled by holding down on the Alt key when dragging or resizing a station.

EPZ19 >~ Ql|k B sv @& Keleve §v My + "F[FT]2v|15min > 4= 1 X G W >
NGEZ19 15m X CLEZ19 15m C & - ™ EPZ1915m X YMZ19 15m + /\ = -
NGEZ19 - 15/min (2,696 EPZ19 - 15 min r -
folurr Snaps to top
3095.00
i fl, i edge of
!l i ﬂ When dragging a station visible area.
near the visible boundary
+' ' and/or the edge of another I
station, it will snap to that 3089.75)
+ Ty W location. Hold down on the <;
ll Snaps to the edge Alt key to disable this
4 ‘ of a station when feature.
dragged near.
“ T ~13085.00
I 25.3K
MotiveWave bt II '“l
640 — 1= = T x
21:00 Nov-14 3:00 6:00 14:00 18:00
1min 5min 10min [ 15min >*2 EvEvyE oy @ |4 @A
Mo\iveWaveY - ” P -Lllllll “ II“II .
21:00 Nov-14 3:00 14:00

1min 5min 10min ‘15min %2

||||I
<
[

cS e @ vt

When resizing an edge of station, it will snap to the edge of a near by station as well. This can be
especially convenient when attempt to make the dimension of the stations the same. In the screen shot
below the height of the station is made to match the height of the adjacent station when resizing from
the bottom edge.
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Station height is
snapped to the
bottom edge of
this station.
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4.2.4 Resizing Snapped Stations

For convenience resizing the top, bottom or sizes of a station that has been snapped to another station
will resize those station(s) as well. This behavior can be turned off by holding down on the Alt key.
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4.2.5 Minimizing Stations

Stations can be minimized to clear clutter from the content area. Click on the minimize button in the
top right corner of the station to minimize it.

T+¢‘W] L j|+ o

“ cuezts - 15 min J,“"% ‘ rminimize btton
W WA

to minimize it.
MotiveWavi T

Js7.40 | Nlu
: : o 2 et |||I|| |||||
21:00 Nov-14 3:00

d

The tab of the
minimized station will
appear at the bottom
of the content area.

14:00

1min 5min 10 min 15min 2 == Er=Elk-eo
‘ﬂ|+  56.98,
. ; : o ‘ 66013
21:00 Nov-14 3:00 6:00 9:00 14:00
1min Smin 10min | 15min | >z v =v = bi-@|-v 8
il Home |l Charts .8 Account |2 Scan  {}f Optimize &M Floating X + + W

The active tab of the minimized station will appear in the bottom left section of the content area
appearing in the order in which they were minimized. Click on a minimized station to restore it to the
content area.
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4.2.6 Maxmizing Stations

A station may be maximized to occupy the entire viewing area. When a station is maximized its size will
change when the window is resized. When the station is restored, its original location and size will be
preserved.

The left and right arrow buttons in the top right corner of the maximized station may be used to cycle
through the stations in the viewing area.
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! l left click on the 1 The station will
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+Jr H2.670 I
~ | ! il i | |
‘ 2660 l l! *
3658 ’ i
*‘ I—*I H2.650
*i ]
J2.840
l 5514i - |
meeWa've - ; - . . (2062§ __m‘{ﬂ(__e ; R 1 y
21:00 Nov-14 3:00 6:00 9:00 14:00 18:00 18:00 21:00 Nov-14 3:00
1min 5min 10 min  15min 12 =y =~ = o~ @ |4~ 1min 5min 10min 15 min  >>12

Version 1.0 ©2019 MotiveWave™ Software Page 23 of 32



MotiveWave™
Docking Framework

motivelwave

NGEZ19 ~ Q| K B s @& I B W~ > My + "8 T &2~|15min - | J5 (W e 1|3 5>

NGEZ19 15m x + | A

NGEZ19 - 15 min

Volume

MotiveWave

Alternatively, a double left
click on the empty section
of the tab bar will restore
the station to its original
size and position.
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will adjust to the available space.
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4.2.7 Creating New Stations

There are several ways to create new stations:

1.
2.
3.
4.

Context Menu — Right click in an open section of the content area

Nov-14 10:38:17

New Station (+) Button — Click on the ‘+’ button on the right side of the page bar

Top Menu Bar — See New Station menu in the Dock section of the top menu bar.
Dragging Station Tabs — Station tabs can be dragged into an open section of the content area.

The following screen shots illustrate the first 3 options for accessing the New Station menu. This menu
contains the available panel types similar to the new panel button in the tab bar of a station. Select the
desire panel type to create a new station.
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Click the + button
and select the panel
type from the list.
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In the screen shot below a new Gauge panel was created resulting in a new station being added to the

layout.
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Nov-14 10:55:37

Alternatively, a new station may be created by dragging the tab of an existing panel from its station into

an empty section of the content area.
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Gauges X

When the mouse button is released in an empty section of the content area, a new station is created
and the panel from the originating station is remove and added to the new station.
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4.2.8 Moving Panels Between Stations

Panels can be moved from one station to another by dragging the tab (left click and drag with the
mouse) into the content area of another station.
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4.2.9 Closing/Removing Stations

A station is removed when the last panel is removed from the station. This will occur when the last
station is either closed or moved into another station.

4.3 Managing Floating Stations

The Dock (top menu bar, only visible from a Floating Station layout) and Context Menus (right click) have
several options for managing stations in the floating layout:

1. Tile Stations — Positions and resizes visible stations into a grid layout

2. Cascade Stations — Arranges and resizes stations from the top left corner of the visible area
3. Restore Stations — Restores all stations from the minimized state

4. Minimize All — Minimizes all visible stations
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5. Station Size — The menu provides preset size (dimension) options
6. Station Access - All visible and minimized stations may be accessed directly from this menu

4.3.1 Tile Stations

This option will position and size all of the non-minimized stations into a grid format with the last station
occupying the remaining space on the bottom row. Choose Dock -> Tile Stations from the top menu bar.
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4.3.2 Cascade Stations

Arranges the non-minimized stations from the top left corner of the content area and offsets them by a
few pixels so the tab labels are visible.
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4.3.3 Station Sizes

motivelwave

Several preset stations sizes are available under the Station Size sub menu. A custom size can be chosen
from a dialog (see Custom Size option). For convenience the active station size can be saved as the

default size when new stations are created.
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4.3.4 Station Access

All stations in the layout are listed at the bottom of the Dock menu. This provides a convenient way to
location a station that is minimized, hidden behind a set of station or is outside of the visible area.
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5 Customization

Customization options can be found in the Preferences dialog (Configure -> Preferences from the
Console menu bar). Click on General, then on Dock. The following options are available:

1. Tab Location — Location of the station tabs (top or bottom)
2. Page Bar Location — Location of the page bar (top or bottom)
3. Show Tab Icons — Optionally displays the icons for the station tabs. These icons indicate the

panel type.
4. Confirm Remove Page — Shows a warning message when deleting a page (on by default).

Theme Chart Tool Bar Sounds Ratios Elliott Wave Harmonics Historical Data OFA® Orders Alerts Emi (»

General Keyboard Mouse Fonts Quick Search Ticker Tape Linking Bl Trading Hours Simulated Account Auto U (=

This panel contains preferences for the docking framework.
Tab Location: | Top -
Page Bar Location: = Bottom ~
Show Tab Icons

v/ Confirm Remove Page

OK | Apply Cancel

The screen shot below shows the console window with the station tabs at the bottom, page bar at the
top and station tab icons enabled.
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5.1 Active Tab Bar Colors

The colors for the active chart and active focus can be customized from the Preferences dialog
(Configure -> Preferences from the Console menu bar). Click on the Theme tab, then on the Theme sub
tab:

® Preferences

General Chart Tool Bar Sounds Ratios Elliott Wave Harmonics Historical Data OFA® Orders Alerts Emi (»

Bar Themes Chart Themes

Themes are used to change the look of the Ul components (Window Theme), chart colors (Chart Theme) and bar colors (Bar Theme).
Use the drop down options below to configure themes for MotiveWave. Click OK to apply your changes.

Window Theme: Light ~
Chart Theme:  Light v
Bar Theme: Red/Blue -
Buy/Sell Colors:  Red/Blue -
Table Row Colors: V| Use Default
Active Chart Station Color: [N ~ Use Default

Active Station Color: @ Use Default

Uncheck Use
Default and
select a color.

OK | Apply  Cancel

The screen shot below shows the customized colors:
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